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必讀 !

此文件翻譯自 Adams 原廠英文教材 ADM701 V2017 , 共精選了8個範例! 適合對 Adams 操作已

有基礎的使用者。若是毫無基礎者, 建議先參考另一份文件“Adams 範例實作練習 (基礎篇)”(詳見

臉書: MSC Software Taiwan)。

此外, 提供以下重要資訊: 

MSC原廠訓練課程: http://www.mscsoftware.com/zh-hans/page/pei-xun-ke-cheng-gong-gao

免費學生版軟體索取請聯繫: jeffrey.lee@mscsoftware.com or ray.lai@mscsoftware.com

編校者: 賴群峯 (Ray Lai), 投入軟體模擬分析工程已超過十年, 專長為機構運動分析, 並具備結構有限元

分析的實務經驗。擅長 CAE 模擬分析以解決工程問題! 現任職於美商 MSC Software 公司。 在此之

前, Ray 在電子業(廣達電腦與台達電子)從事機構設計與模擬分析, 對產品開發與生產流程亦十分熟悉!

包括: 筆電、平板電腦、電子紙與電子書閱讀器等等。

Year 2019

聯絡方式: LinkedIn: https://www.linkedin.com/in/ray-lai-motion-analysis

賴群峯

http://www.mscsoftware.com/zh-hans/page/pei-xun-ke-cheng-gong-gao
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a. 開啟Adams View

b. 從Welcome dialog box點選 Existing Model.

c. 點選File Name最右邊的資料夾符號
d. 找Exercise_dir/mod_2_aview_interface 下的 valve.cmd 並點選開啟舊檔.

e. 點選OK

Step 1. Import File

b

c d

e

記得打勾～
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Adams View在操作時有很多的快捷鍵可以使用，來加快界面的操作

若忘記快捷鍵可以利用快捷鍵選單來查找

也可以直接在快捷鍵選單點選想要使用的功能

a. 將滑鼠移到空白處按右鍵，快捷鍵選單即會出現

b. 在快捷鍵選單外點左鍵，快捷鍵選單即會關閉

Step 2. View the List of Keyboard Shortcuts

大寫的記得
要按Shift 

再按字母

a b

下一頁要用
這個哦～

還要用這個
哦～
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c

e

b

使用zoom Box快捷鍵做局部放大:

a. 按鍵盤上的<w>

b. 左下角的Status Bar會提示下一步

c. 在你想要放大的區域的左上角點左鍵，並按
住

d. Status bar顯示:drag to select size of view.

e. 拉出一個框，將cam圍起來. 

f. 放開左鍵，視窗即會方法到框選區域

g. 鍵盤按<f>就會回到原來的大小

Step 3. Use the Zoom Box Shortcut 

f

d

wa

f

g
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若要使用Admas預設好的視角查看模型，
可以分別使用<T>、<I>、<R>快捷鍵查看
上、等角及右視圖

大家也可以自己試試看其他的快捷鍵哦～

Step 4. View the Model from Different Angles

Top View

Right View

Isometric View

Shift + t

Shift + i

Shift + r
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請按照左下角的圖將每個part重
新命名

a. 在模型樹(Model Browser), 

找到在Bodies分支下的
PART_1到PART_5

b. 按右鍵並選擇Rename 來重
新命名

c. 在 Rename 視窗， 根據右上
角的圖來重新命名

d. 按 OK 重新命名

e. 重複以上步驟將其他的part也
重新命名.

Step 5. Rename the Parts 

Rod

Cam

Rocker

Guide 

(ground)

Valve

a

b

c

d

名稱前面的.valve

是model的名稱，
小心不要改到哦～
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檢查模型的拘束條件是否建立正確:

a. 在 Status bar 的右邊找到 Information 

tool stack 點擊右鍵展開所有選項

b. 點選 Model topology by constraints

tool.

c. 查看顯示的內容

d. 關閉視窗.

Step 6. Inspect the Model 

b

a

c

d
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驗證模型時，Adams View會幫忙檢
查一些錯誤的模型定義，並且提出
警告，像是：沒有對齊的連結、沒有
被固定的零件、或是在動態系統中
沒有質量的零件等問題.

a. 在 Status bar 的右邊找到
Information tool stack 點擊右
鍵展開所有選項, 點選 Verify 

tool.

b. 在 Information window 確認是
否顯示 Model verified 

successfully.

c. 關閉 Information window.

Step 6. Inspect the Model (Cont.)

a

b

c
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To run a simulation:

a. 點選標籤頁 Simulation.

b. 點選 “Run an Interactive 

Simulation.”

b. 在Simulation Control 目錄中，
在 End Time 文字方塊 2.0.

c. 在 Steps 文字方塊輸入 100.

d. 按 Play.

e. 當模擬完成後，按 Reset 來結束
模擬.

Step 7. Simulate the Model 
a

b

c d

e

fg



ADM701, Workshop 2, March 2017

Copyright©  2017 MSC Software Corporation
WS2 - 10

將此次模擬結果存檔，以利之後與不同模擬做比較:

a. 點選Simulation Control視窗左下角的 Save simulation tool. 

Save Run Results 視窗即會跳出

b. 在 Name 文字方塊輸入此次模擬的名稱 first_results.

c. 點 OK.

d. 關閉 Simulation Control 視窗.

Step 8. Save the Simulation

a

d

c

b
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To Animate the results in the default 

mode with icons off:

a. 按 Simulation Control視窗下面中
間的按鈕來切換到Animation 

Controls視窗.

b. 播放動畫按 Play.

c. 動畫播放完成後按 Reset.

d. 若想要一幀一幀的看，可以按 +Inc

或 -Inc 看下一幀或前一幀.

e. 在+Inc跟-Inc中間的數字代表現在看
到第幾幀. 

f. 查看完畢按 Reset. 

若想要在看動畫是把標記打開:

g. 在Animation Control視窗的右下角
有個選項 icons，把它打勾.

h. 剩下的步驟跟 b. to f. 一樣
i. 關閉Ainumation Control視窗. 

Step 9. Animate the Results

a

g

bc

d e

f

d

i



ADM701, Workshop 2, March 2017

Copyright©  2017 MSC Software Corporation
WS2 - 12

存成 .cmd 檔:

a. 從 File 選單找到 Export.

b. 確認 File Type 是設定成
Adams View command File.

c. 在File name輸入 valve1，按
OK.

d. 存檔完成即可關閉 Adams 

View.

Step 10. Save Your Work

b

c

a

這個名字是可
以改成你希望
看到的檔案名

稱

這個名字是

不可以改的，

它代表了你想
要存哪個模型

用這個存檔的話
會存成 .bin 檔
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WORKSHOP 4

FALLING STONE

自由落體
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建立新的Adams模型:

a. 開啟Adams View.

b. 從歡迎界面點選 New Model..

c. 將工作目錄(Working Directory)

設定在
exercise_dir/mod_04_falling_

stone.

d. 將模型命名為 Projectile.

e. 確認重力(Gravity) 是設定為
Earth Normal (-Global Y).

f. 確認 Units 是設定為 MMKS -

mm, Kg, N, s, deg.

g. 按下 OK.

Step 1. Create a New Model

d

b

e

cf

g
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To build the stone:

a. 從 View 選單中點選
Coordinate Window. 坐標視窗
可以提供目前滑鼠所在的坐標

b. 從Bodies標籤頁, 點選 Rigid 

Body: Sphere.

c. 點選完左邊視窗會產生Sphere

工具欄，從選單中點選 New 

Part.

d. 將 Radius 前的方塊打勾.

e. 在 Radius 的文字視窗輸入
(50mm). 

f. 將滑鼠移動到坐標（0，0，0）, 按
左鍵，建立圓球.

Step 2. Build the Stone

b

f

c

d

a

e
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將新產生的PART重新命名:

a. 從模型樹（Model Browser）找
到 Bodies 並點左邊的 + 號展
開. 點選 PART_2 圓球即會點亮.

b. 在 PART_2 上按右鍵, 從選單裡
點選 Rename. 

c. 在 New Name 文字方塊, 將
PART_2 改成 Stone, 完成後點
選 OK. 

Step 3. Rename the Stone

c

b

a

c

名稱前面
的.Projectile是

model的名稱，小
心不要改到哦～
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將質量設定為1 kg:

a. 從模型樹（Model Browser）, 找
到 Bodies 下的 Stone, 按右鍵
列出選單，並點選 Modify.

b. 在 Define Mass by 選單中, 選
擇 User Input.

c. 在 Mass 文字方塊輸入 1.0.

d. 按 OK.

Step 4. Set the Mass of the Stone

a

b

c

d
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建立 y 方向的量測:

a. 在模型樹里的Stone上按右鍵選擇
Measure, Part Measure視窗就
會出現.

b. 在 Measure Name 文字方塊輸入
這個量測的名字 displacement.

c. 將 Characteristic 設定為 CM 

position, 以量測質心的位置.

d. 將分量(Component) 設為 Y, 以
量測y方向的位置.

e. 將 Create Strip Chart 打勾.

f. 按 OK.

g. 一個量測圖表即會顯示, 跑過一次
模擬後, 上面即會顯示 y 方向位移
對時間的曲線

Step 5. Create Measures for the Falling Stone

a

c

d

e

f

b

g
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接著再建立 y 方向的速度與加速度
量測:

a. 按照前一頁的步驟進行, 打開
Part Measure視窗

b. 將名稱改為 velocity 

(acceleration)

c. Characteristic 選擇 CM velocity 

(CM acceleration)

d. 選擇Y分量

e. Create Strip Chart 打勾

f. 按OK

速度建立完記得還有加速度哦～

Step 5. Create Measures for the Falling Stone

b

c

d

e

f

g

a
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驗證模型時，Adams View會幫忙檢
查一些錯誤的模型定義，並且提出
警告，像是：沒有對齊的連結、沒有
被固定的零件、或是在動態系統中
沒有質量的零件等問題.

a. 在 Status bar 的右邊找到
Information tool stack 點擊右
鍵展開所有選項, 點選 Verify 

tool.

b. 在 Information window 確認是
否顯示 Model verified 

successfully.

c. 關閉 Information window.

Step 6. Verify the Model

a

b

c
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因為模擬時，球會一直往下掉，為了
能夠觀察模擬時間內的全部過程，
我們需要先把視窗縮小並往上移:

a. 點選放大工具(Zoom tool) 或者
也可以使用快捷鍵 z, 在視窗空
白處點左鍵並向下拖移直到可以
看到整個網格(Working Grid).

b. 點選移動工具 (Translate tool) 

或者也可以使用快捷鍵 t, 在視
窗空白處點選並向上拖移直到圓
球處於視窗的上端.

Step 7. Run the Simulation ab
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接下來要做一個1秒50步的模
擬:

a. 從標籤頁 Simulation, 點
選 “Run an Interactive 

Simulation.”

b. 在Simulation Control 目錄
中，在 End Time 文字方
塊 1.0, 在 Steps 文字方
塊輸入 50.

c. 按 Play.

d. 在石頭往下掉的同時，
Adams會把量測的數據畫
在量測圖表內

e. 當模擬完成後，按 Reset 

來結束模擬.

f. 按動畫(Animation) 來查
看模擬動畫.

Step 7. Run the Simulation

d

a

a

b

c

e

b

f
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為了查看1秒後石頭的位置，我們需要將
量測結果顯示在後處理界面中:

a. 在 displacement 量測圖表的空白處
點右鍵，找到 Plot:scht1 ，點選
Transfer To Full Plot.

b. Adams PostProcessor 界面就會出現.

c. 在 main toolbar 點選 Plot Tracking 

tool.

d. 將滑鼠移動到曲線的最右邊, 可以觀察
到在移動的同時左上角X、Y的數值會
變化.

e. 當X 顯示 1 時, Y的數值就是1秒時石
頭的位置.

Step 8. Find the Value of the Stones 

Displacement

a

c b

d

e
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按照同樣的方法我們也可以找到1

秒時的速度:

a. 將右下角的 Surf 打勾. 

b. 將 Source 設定為 Measures.

c. 從 Measure 列表, 選擇
velocity.

d. 接這按照上一步的步驟c、d、e

查看1秒時的速度

e. 按照一樣的方式，查看1秒時的
加速度

Step 9. Find the Value of the Stones Velocity

a

b

c
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存成 .cmd 檔:

a. 從 File 選單找到 Export.

b. 確認 File Type 是設定成
Adams View command File.

c. 輸入檔名，按 OK.

d. 存檔完成即可關閉 Adams 

View.

Step 10. Save Your Work

b

c

a

這個名字是可
以改成你希望
看到的檔案名

稱

這個名字是

不可以改的，

它代表了你想
要存哪個模型

用這個存檔的話
會存成 .bin 檔
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WORKSHOP 5

PROJECTILE MOTION

拋物線運動
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To import a file:

a. 開啟Adams View.

b. 從 Welcome 視窗選擇 Existing Model.

將工作目錄設定在 mod_05_projectile
c. 點 Working Directory 最右側的資料夾符號，

並在 Select Directory 視窗找到
exercise_dir/mod_05_projectile. 

d. 點 Select folder 以選擇資料夾作為工作目
錄.

開啟前次練習存檔的 projectile.cmd
e. 特別注意上次存檔時 projectile.cmd 是存在

exercise_dir/mod_04_falling_stone， 並
不是這次的工作目錄.

f. 點 File Name 最右邊之齒輪資料夾符號
g. 在 exercise_dir/mod_04_falling_stone 資

料夾中找到上次完成的 projectile.cmd.

h. 如果上次沒有存檔，也可以從
exercise_dir/mod_04_falling_stone/com
pleted/ 內找到 stone_completed.cmd 做
開啟.

i. 點 OK.

Step 1. Import File

b

c

d

g

c

h

f

這次開啟檔案的位置並
是不在工作資料夾，記
得把這個打勾拿掉哦～
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Build the plane:

a. 從 Settings 選擇
Working Grid.

b. 在 Size: X 文字方塊輸
入 4000.

c. 在 Size: Y 文字方塊輸
入 3000.

d. 在X跟Y的 Spacing 文
字方塊都輸入 50， 點
OK.

e. 利用快捷鍵 z 做縮放，
按鍵盤上的 z 後，在視
窗內按住滑鼠左鍵，做
上下拖移，即可縮放，將
畫面縮小至可以看到真
個工作格點(Working 

Grid)

Step 2. Build the Plane

b c

d

e

a

d
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a. 利用 View >Coordinate 

Window 來開啟 Coordinate 

Window

b. 從 Bodies 標籤頁選擇 Box 

tool.

c. 在Box工具欄中:

• 設定為 On Ground.

• 把 Length 打勾，並在文字
方塊輸入 3500 mm.

• 把 Height 跟 Depth 打勾，
並在文字方塊輸入 100 mm.

d. 移動滑鼠直到 Coordinate 

Window顯示滑鼠坐標為 0, -

150, 0， 點左鍵.

e. 白色方塊即會產生，上個練習建
立的球則會剛好在方塊的邊緣.

Step 2. Build the Plane

a

e

b

c

d

如果產生的方塊不是白
色的，說明這個方塊並
沒有放在 ground 上面，

請重新設定哦～

設定為on Ground

就說明這個方塊在
整個模擬過程中是

不會有位移的
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我們要將x、y方向的初速射設定為：

Vx0 = 6000*cos(60°) = 3000 

mm/sec

Vy0 = 6000*sin(60°) = 5196 

mm/sec:

a. 在模型樹的Bodies下找到 stone，
點右鍵，選擇 Modify.

b. 將 Category 設定為 Velocity 

Initial Conditions.

c. 在 Translational velocity

along 下找到 X axis 並打勾，
在後方的文字方塊輸入
(6*cos(60d)(m/sec)) 或
(3000(mm/sec)).

d. 在 Translational velocity

along 下找到 Y axis 並打勾，
在後方的文字方塊輸入
(6*sin(60d)(m/sec)) 或
(5196(mm/sec)).

e. 按 OK.

Step 3. Set Up Initial Conditions

a

b

c

d

e
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我們在前一次的練習已經建立了y方
向的量測, 這次加上了初始速度，球
不但會往下落，還會有x方向的位移，
因此現在來建立x方向的量測:

a. 在模型樹下找到 stone ，點右鍵，
選擇 Measure.

b. 在 Measure Name 文字方塊輸
入 R_displacement.

c. 將 Characteristic 設定為 CM 

position.

d. 將 Component 的 X 打勾.

e. Create Strip Chart 打勾.

f. 點 OK.

g. R_displacement 的量測圖表就
會顯示. 

Step 4. Create a Measure for the Projectile 

Motion

a

b

c

d

e

f

g
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接下來進行1.5秒，步長0.02秒
的模擬:

a. 從標籤頁 Simulation, 點選
Run an Interactive 

Simulation(一個齒輪的符
號).

b. 在 End Time 文字方塊輸
入 1.5.

c. 把 Steps 改成 Step Size.

d. 在Step Size後的文字方塊
輸入 0.02.

e. 按 Play.

f. Adams View在求解的同時，
也將結果繪製到
R_displacement 的量測圖
上.

g. 模擬結束後，點擊 Reset.

Step 5. Run the Simulation

f

a

b

c

eg

d
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看石頭飛了多遠:

a. 從 Result 標籤頁，點選
Animation Control Dialog 

box.

b. 按 Play.

c. 當發現石頭跟地面接觸時按
Stop.  

d. 利用 +Inc 跟 –Inc 找到石頭
跟地面接觸的準確時間.

e. 視窗的左上角會顯示當下的
時間

f. 找到接觸那一剎那的時間後，
按 reset.

Step 6. Find the Time at Which the Stone Makes 

Contact with the Plane

e

a

bc

d

f
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可以利用 point trace 功能，來標
記出某一點在整個模擬過程中的
軌跡:

a. 將Animation Control 視窗中
的 No Trace 改成 Trace 

Marker.

b. 右擊空白的文字方塊，選擇
Marker, 接著選擇 Browse.

c. Database Navigator視窗即
會跳出，從中選擇 Stone 下
面的 cm, 按 OK 後, 原本空
白的文字方塊即會顯示
Stone.cm .

d. 點擊 Play.

e. 在動畫播放的同時，也會看到
Stone在整個模擬過程中移動
的軌跡.

f. 關閉 Animation Controls 視
窗.

Step 7. Create a Point Trace of the Projectile 

Motion

e

d

c

b

a

f

b
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找出石塊的水平移動距離:

a. 在 R_displacement 量測圖
的空白處點擊右鍵, 選擇 Plot: 
scht1, 點擊 Transfer to Full 
Plot.

b. Adams PostProcessor視窗就
會出現.

c. 點擊 Plot Tracking tool.

d. 我們在前面的步驟已經知道了
石塊接觸地面的時間，因此我
們移動滑鼠，直到左上角的X
顯示的數字等於接觸的時間

e. 此時的 Y 就是石塊的水平移
動距離.

f. 關閉Adams PostProcessor視
窗，回到Adams View界面.

Step 8. Find the Horizontal Displacement 

a

b

d

c

e

g
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這次存檔成 .bin 檔，bin檔不止包含
模型的資訊，也會包含模擬的結果:

a. 從 File 選擇 Save Database 

As.

b. 在 File Name 文字方塊輸入
projectile, 點擊 OK.

c. Adams即會產生包含模型、模擬
結果的 .bin 檔案在工作目錄裡
了

d. 關閉 Adams View.

Step 9. Save Your Work

b

b

a

複習一下，如果要
存成 .cmd 檔記得
使用Export哦～
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WORKSHOP 6

ONE DOF PENDULUM

單自由度單擺
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建立新的模型:

a. 開啟Adams View，點選 New Model 並將工作目
錄設為 exercise_dir/mod_06_pendulum.

b. Model Name 輸入 pendulum, 其他的採用預設
選項.

a. Gravity 為 Earth Normal (-Global Y)

b. Units 為 MMKS - mm, Kg, N, s, deg.

建立連桿:

c. 按 F4 或從 View>Coordinate window 打開
Coordinate window.

d. 從 Bodies 標籤頁點選 Link tool.

e. 在跳出的 Link工具欄:

• 選擇 New Part.

• 將 Length 打勾，並在後面的文字方塊輸入
450 mm 按 Enter.

• 將 Width 打勾，並在後面的文字方塊輸入 20 

mm 按 Enter.

• 將 Depth 打勾，並在後面的文字方塊輸入
27.5 mm 按 Enter.

f. 移動滑鼠，第一個點點在 0, 0, 0 的位置，第二個
點在 450,0,0 的位置.

g. 若沒辦法點到上面這兩個點，則可以在空白處點
右鍵即會出現 LocationEvent視窗，輸入 0,0,0 按
Apply, 在空白處再點一次右鍵， 輸入450,0,0 按
Apply. 

Step 1. Create a New Model and Build the 

Pendulum Link

f

c

f

d

e

d
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To build the sphere section:

a. 從標籤頁 Bodies 選擇 Sphere 

tool.

b. 在工具列:

• 把 New Part 改成 Add to 

part.

• 將 Radius 打勾並在文字方
塊輸入 25 mm, 按 Enter.

c. 用滑鼠左鍵點擊 PART_2, 作為
要加入的Part.

d. 用滑鼠點選 450,0,0 作為球心的
位置.

Step 2. Build Sphere Section

a

b

c d

如果球跟連桿不是同
一個顏色說明他們不
在用一個Part地下，
要重新建立圓球哦！

特別注意是不是有
把New Part改成

Add to Part
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將單擺重新命名:

a. 在模型樹右鍵點擊PART_2，選
擇 Rename.

b. 在 New Name 把 PART_2 改成
pendulum, 改完後名字全稱
為 .pendulum.pendulum, 按
OK

Step 3. Rename the Pendulum

a

b

b

再次提醒！不 要改到

前面的 .pendulum. 
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設定單擺的質量:

a. 右鍵點擊 Bodies 下的
pendulum 並選擇 Modify.

b. 將 Define Mass by 設定為
User Input.

c. 在 Mass 文字方塊輸入 2.0.

d. 在 Inertia 文字方塊 (Ixx, Iyy, 

Izz)都輸入 0.

e. 在 Center of Mass Marker 文
字視窗點右鍵，找到
pendulum.pendulum.cm, 並
選擇 Modify.

f. 在 Location 文字方塊輸入 450, 

0, 0.

g. 按 OK.

Step 4. Set the Mass

a
b

c

d

e

f

g
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a. 在點擊 OK 後，Adams會跳
出提醒視窗，提醒我們已經
將質心的位置做更改，現在
的質心位置並不是根據CAD

計算出的質心.

b. 點選 Close 關閉視窗.

c. 模型應該看起來如下圖:

Step 4. Set the Mass

a

b

c
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To build the pivot:

a. 從標籤頁 Connectors 選擇
Revolute joint tool.

b. 從工具箱選擇 2 Bod-1 Loc 和
Normal to Grid (基本上是預設
選項，不用動).

c. 點選 pendulum 作為 first 

body.

d. 點選 ground (空白處) 作為
second body.

e. 選擇 0, 0, 0 作為 location.

Step 5. Build the Pivot

a

b

e

c

d

First body會以
location的Normal to 

grid的方向為轉軸，相
對於second body旋轉
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將Joint重新命名:

a. 在 Model Browser 下找到
JOINT_1 按右鍵並選擇
Rename.

b. 在 New Name 文字方塊內，將
JOINT_1 改成 pivot， 按 OK.

Step 6. Rename the Pivot

a

b

b
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測量Joint上X方向的受力:
a. 從 Model Browser 找到 pivot 右鍵點擊，

並點選 Measure.  Joint measure 視窗即
會出現.

b. 在視窗中分別填入:
• 在 Measure Name 文字方塊輸入

pivot_force_x.
• 將 Characteristic 設定為 Force, 並

在 Component 選擇 X.
• Select Apply.
• 確認 From/At 所選擇的 Marker 是屬

於pendulum的.
• 確認左下角的 Create Strip Chart 有

打勾

測量Joint上Y方向的受力:

a. 與上方的設定均相同，只有裡那個個地方
需要更改：
• 在 Measure Name 文字方塊輸入

pivot_force_y.
• Component 選擇 y.

Step 7. Create Tracking Measures

a

b

cb
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建立參考Marker:

a. 在 Bodies 標籤頁選擇在
Construction 裡面的
Marker tool.

b. 在Marker 工具列裡面確定是
選擇 Add to Ground 和
Global X.

c. 左鍵點選 600, 0, 0 作為
Marker 的位置，或在空白處
按右鍵輸入600, 0, 0.

d. 在模型樹下找到 ground，並
找到在 ground 下面的
MARKER_6 右鍵點擊選擇
Rename.

e. 在 New Name 文字方塊將
MARKER_6 改成
angle_ref, 並點擊 OK.

Step 8. Create a Reference Marker

b

e

c

a

e
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建立角度量測:

a. 在 Design Exploration 標籤
頁內點擊 Measures 裡的
Create a new Angle 

Measure.

b. 在 Angle Measure 工具列點
擊 Advanced.

c. 在 Measure Name 文字方塊
輸入 pend_angle.

d. 在 First Marker 文字方塊點擊
右鍵, 選擇 Marker 點擊 Pick.

e. 在pendulum的右端，點擊右鍵
便會跳出那附近所有的Marker，
點選 pendulum.cm .

f. 在 Middle Marker 文字方塊點
擊右鍵, 選擇 Marker 點擊
Pick.

f. 在 Joint 端點擊右鍵便會跳出
那附近所有的Marker，點選
Marker_1 .

a. 在 Last Marker 文字方塊點擊
右鍵, 選擇 Marker 點擊 Pick.

f. 在視窗中點選剛才建立的
angle_ref

g. 按 OK

Step 9. Create Angle Measure

a

c

f
d

b
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設定

角度位置的初始條件 θ0 = 30º

角速度的初始條件 θ0 = 300º/sec :

a. 從模型樹裡找到 Joint 下的 pivot 點
擊右鍵, 並點擊 Modify. Modify joint 

視窗就會出現.

b. 點擊 Initial Conditions.

c. 將 Rot. Displ. 跟 Rot. Velo.都打勾，並
分別在文字方塊輸入:

• -30.

• -300.

d. 在 joint initial conditions 視窗點擊
OK.

e. 在 modify joint 視窗點擊 OK.

Step 10. Set Up the Initial Conditions

c

d

b

a

e
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驗證模型:

a. 在 Status bar 最右端找到
Information tool stack(藍色
圓圈中間一個i) 右擊選擇
Verify tool(黃色方塊綠色勾
勾)

• 可能會有一個warning寫:

the initial conditions for 

the joint position does 

not match the design 

configuration. 這是沒問
題的.

b. 關閉視窗

Step 11. Verify Your Model

b

a
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進行模擬:

a. 進行一個 2 秒 100 步的模擬.

To determine the global components (x, 

y) of the initial force supported by the 

pivot. 

b. 在pend_angle 量測圖表的空白處點
右鍵, 指到 Plot: scht1, 並選擇
Transfer to Full Plot. (跟上一個
workshop一樣)

c. Adams PostProcessor 就會出現.

d. 選擇 Plot Tracking.

e. 將滑鼠移到 t =0 的位置.

f. 讀取Y的數值.

g. 將下方的 Source 改成 Measures.

h. 從 Measure 列表選擇
pivot_force_x.

i. 將右側的 Surf 打勾.

Step 12. Run Simulation and Determine 

Components

a

e

g

i

h

d

f

c
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j. 將滑鼠移到 t = 0.

k. 讀取Y值

l. 從 Measure 列表選擇
pivot_force_y.

m. 將滑鼠移到 t = 0.

n. 讀取Y值

Step 12. Run Simulation and Determine 

Components (Cont.)

n

m

l

k

j
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WORKSHOP 9

LIFT MECHANISM II

舉升機構
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匯入模型:

a. 從歡迎視窗選擇 Existing Model.

b. 將工作目錄設定在
exercise_dir/mod_09_lift_mech_2.把 Use File 

Directory as Working Directory 的打勾拿掉.

c. 從 exercise_dir/mod_08_lift_mech_1/completed 找
到 lift_mech_I_completed.cmd 打開.

增加拘束條件:

d. 利用 Fixed joint 將 base 固定在 ground.

• 在 Connectors 標籤頁下點擊 Create a Fixed 

Joint

• 不需更改任何預設設定

• 先點擊 Bsae在點擊 ground，最後選擇固定位置
Base.cm

e. 利用 revolute joint 將 mount 固定到 base:

• 在 Connectors 標籤頁下點擊 Create a Revolute 

Joint

• 使用預設的 2 Bod-1 Loc

• 更改 Normal to Grid 為 Pick Geometry Feature.

• 先點擊 Mount 再點擊 Base， 選擇 Mount.cm作為
固定位置.

• 選擇任何與 Global y方向平行的坐標軸作為旋轉方
向.

Step 1. Import Model and Constrain Parts

e

d
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a. 利用 revolute joint 將
shoulder 固定到 mount :

• 利用 Normal To Grid.

• 先點擊shoulder，點Mount，
再點Mount.cm.

b. 利用 translational Joint  將
boom 固定到 shoulder:

• 使用 Pick Feature.

• 先點選 boom， 點 shoulder，
點 shoulder.cm, 最後選擇一
個與 global X方向平行的坐
標軸當作方向.

c. 利用 revolute joint 將 bucket 

固定到 boom :

• 利用 Normal To Grid.

• 選擇圓柱的左端點作為旋轉
中心的位置

Step 1. Constrain Parts

b

a

c
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To verify your model:

a. 在 Status bar 右鍵點擊
Information tool stack, 並選擇
Model topology by 

connections， 所有的part是否
均已連接好.

b. 進行模擬

Step 2. Verify and Simulate

a

a
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增加Joint Motion:

a. 先利用預設在所有的revolute 

joint 建立 Rotational Joint 

Motion (A) ,在所有的
Translational Joint 建立
translational motion (B). 

• 下面再利用在模型樹裡用
右鍵選擇 Modify 來修改每
個 Motion .

b. 將連接 mount跟 base 的
revolution joint 的motion的
Function修改為:

• D(t) = 360d*time

Step 3. Add Joint Motion

b

A

B

a
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a. 將連接 shoulder跟 mount 的 revolution joint 的motion

的 Function修改為:

• D(t) = -STEP5(time, 0, 0, 0.10, 30d)

b. 將連接 boom 跟 shoulder 的 translation joint 的motion

的 Function修改為::

• D(t) = -STEP5(time, 0.8, 0, 1, 5)

• Note: if arm is angled downwards, remove (-). 

Right hand rule.

c. 將連接 bucket 跟 boom 的 revolution joint 的motion的
Function修改為::

• D(t) = 45d*(1-cos(360d*time))

Step 3. Add Joint Motion (Cont.)

c

a

b
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a. 進行一個 1 秒 100步的
模擬.

b. 利用 File > Export 輸
出 .cmd檔.

Step 4. Run Simulation and Export
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下面是分析過程

Step 4. Run Simulation and Export (Cont.)
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WORKSHOP 14

SPRING DAMPER

彈簧阻尼系統
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To create a model:

a. 在歡迎界面點選 New Model 並
將工作目錄設定為
exercise_dir/mod_14_spring_

damper.

b. 建立名為 spring_mass的模型.

To build and constrain the model:

c. 使用預設大小，在任意位置建立
一個方塊，改名為 block，並更改
質量為 187.224.(在模型樹里面
在block點右鍵，選擇Modify 將
Define Mass By 設定為 User 

Input，並在下方的Mass文字方
塊輸入187.224).

d. 使用 Translational Joint 限制方
塊只能在global y方向移動.

Step 1. Create, Build and Constrain New Model

d

c
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To add a pre-defined spring damper:

a. 按照前面Workshop所講的，將
Working Grid的原點移動到 block的
cm.

b. 在 Force 標籤頁裡找到 Flexible 

Connection 裡面的 Create a 

Translational Spring Damper

c. 在跳出的 Spring 工具列裡面將 K、
C打勾，並分別輸入5跟0.05

d. 點選 block.cm 作為 Spring 的一個
端點

e. 在任意空白處點右鍵叫出 Location 

Event.

f. 把 Rel. to Origin 更改為 Rel. to 

Grid.

g. 輸入 0, 400, 0 作為彈簧的第二個端
點.

h. 點 Apply.

Step 2. Add the Pre-defined Spring Damper

a

g

e

f
c

d
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To find the force at static equilibrium:

a. 進行一次靜態模擬，在Simulation 

Control視窗內，將 Sim. Type選擇為
Static，並按 Play.

b. 如果紅色箭頭沒有顯示數字的話，選
擇 Settings 並點選 Force Graphics. 

將 Display Numeric Values 打勾.

c. 縮小，直到看到箭頭及數字.

確認是否與下列數值相同:

187.224 kg * 9806.65 mm/s2 = 

1836.04 N

Step 3. Find the Force in Spring Damper at 

Static Equilibrium

a

cb
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建立量測:

a. 在 Design Exploration標籤頁裡
面Measures下，點選 Create a 

point-to-point measure

b. 在出現的工具欄中點選
Advance， 將Measure name 設
為 spring_length, To Point 選
擇 MARKER_6， From Point選
擇 block.cm. 按OK

c. 進行 2秒, 50步的模擬.

• Spring_length量測在 t=0 時
應該顯示為 400 mm.

Step 4. Run a Simulation and Create a Measure

a

b
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計算自然頻率:

a. 再跑一次 static 

equilibrium simulation.

b. 不要 reset.

c. 在Simulation Control 裡
找到 Compute Linear 

Modes tool.

d. 按 Show Table.

e. 跳出的視窗內即會顯示
此彈簧質量阻尼系統的
自然頻率

Step 5. Find the Natural Frequency

a

c

d

e
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• To save your work:

a. 存檔為 .cmd

b. 關閉 Adams View.

Step 6. Save Your Work
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WORKSHOP 15

NONLINEAR SPRING

非線性彈簧
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To import file:

a. 在Adams歡迎界面點選 Existing Model 

並設定工作目錄在
exercise/dir/mod_15_nonlinear_sprin

gs.

b. 並開啟位於
exercise_dir/mod_14_spring_damper/ 

complete 的 spring_mass_completed.

刪除設定好的 pre-defined 彈簧阻尼，建立
user-defined 的線性彈簧阻尼:

d. 在 Model Browser >右鍵點擊
SPRING_1>Delete, 刪除原有的彈簧阻尼

e. 在 Forces 標籤頁，點擊 Create a single-

component

f. 將 Run-time Direction設定為 Two 

Bodies

g. 將 Characteristic設定為 K and C

h. 將K跟C打勾，分別輸入5.0跟0.05

i. 分別點擊 block 跟 ground作為力所施加
的物體，然後點擊 block.cm 跟
ground.MARKER_6 作為力的作用點

Step 1. Import File and Replace the Predefined 

Spring Damper
e

f

h

g

d
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a. 在模型樹裡右鍵點擊
SFORCE_1, 選擇 Info. 檢查看
看function那欄所顯示的是否與
講義Section 14, slide 7 寫的一
樣. 我們剛才在設定時選擇K 

and C Adams就會自動幫我們
建構好這個function，我們當然
也可以自己輸入.

b. 在模型樹裡右鍵點擊
SFORCE_1選擇 Measure.

c. 建立一個名為 spring_force的
量測:

d. Characteristic設為 Force

e. Component 設為 mag

f. 進行 2秒, 50步的模擬，觀察其
震盪的現象.

Step 2. Measure Action-Reaction Force

b

e

c

d

a

f
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a. 將此次模擬存檔，名為 linear_force.

b. 在後處理繪製 spring_force對 Spring_Length 的圖. 

可以注意到斜率並不是正好等於5，那是因為有阻尼的關係.

Step 2. Measure Action-Reaction Force (Cont.)

b

a
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接下來我們要把線性彈簧阻尼更換成非線性彈簧.

匯入非線性彈簧參數:

a. 從 File 選擇 Import.

b. 將下列參數設定好後，選擇 OK.

• File Type: Test Data

• Create Splines

• File to Read: 

exercise_dir/mod_15_nonlinear_spring/spring_data.txt

• Independent Column Index: 1

• Units: Force

• Model Name: .spring_mass

• “Names in File” 不要打勾

c. 匯入後，可在模型樹的Elements > Data Elements下找到
SPLINE_1

Step 3. Change to a Nonlinear Spring

b

a
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a. 從模型樹的 Data Elements 右鍵點擊 Modify 開啟
SPLINE_1

b. 查看SPLINE_1的內容: 開啟視窗從右上角將View 

as 改為 Plot

c. 從模型樹的 Forces右鍵點擊 Modify 開啟
SFORCE_1, 點擊 Function 欄位右方三個小點圖
示

d. 如圖所示,輸入 AKISPL 方程式

Step 4. Create Spline

a

c

The I and J markers in the DM 

function

might be different in your model.

d
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跟線性彈簧的結果做比較:

a. 進行 2秒, 50步的動態模擬來驗證更換後的非線性彈簧正常運作.

b. 將模擬結果存檔為 non_linear_force.

c. 將下列兩個圖做疊圖:

• spring_force vs. Spring_Length 從 linear_force simulation

• spring_force vs. Spring_Length 從 non_linear_force 

simulation

Step 5. Compare the Forces

c

b

a
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WORKSHOP 16

SUSPENSION-STEERING SYSTEM II

轉向機構
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匯入模型:

a. 在歡迎界面選擇 Existing Model 將
工作目錄設定在
exercise_dir/mod_16_susp_steer

_2.

b. 開啟 susp_steer_2_start.cmd.

進行一次基線模擬，作為更換joint後的對
照組:

To run a baseline simulation:

c. 確認steerwheel_motion的function是
常數 0º (Displacement(time) = 0d).

d. 進行1 秒 50 步的模擬.

e. 將模擬結果存檔為 with_joint.

Step 1. Import Model and Run a Baseline 

Simulation

e

d

c

e
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抑制revolute joint.

To deactivate the revolute joint:

a. 在模型樹里找到
lowerarm_grnd_rev點右鍵.

b. 選擇 (De)activate.

c. 把 Object Active 的打勾拿掉.

d. 在模型樹內此關節就會顯示被抑
制.

Step 2. Deactivate the Revolute Joint

a

c

d

b
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在 Lower_Arm跟 ground 之間建立bushing.

To create bushings:

a. 從 Forces 標籤頁, 選擇在 Flexible Connections 裡的
Bushing.

b. 建立後方的bushing，在工具欄選擇 2 Bod-1 Loc, Pick 
Feature:

c. First Part在視窗點選 Lower_Arm

d. Second Part在視窗點選 ground

e. Location 在視窗點選 HP4

f. Direction Vector (+z axis) 在視窗點
選 .Lower_Arm.bushing_ref的 Z-direction.

Tip: To easily find the marker .Lower_Arm.bushing_ref, 
find and select bushing_ref under Lower Arm tree in the 
Model Browser, which will highlight it in Adams View 
Model.

Step 3. Create Bushings

b

a
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在模型樹地下找到BUSHING_1 點右鍵選擇Modify，並輸入如下圖的參數:

a. K translational

b. C translational

c. K Rotational

d. C Rotational

Step 4. Modify Bushings

b

c

a

d
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接著再建立另一個連接點的Bushing:

a. First Part在視窗點選 Lower_Arm

b. Second Part在視窗點選 ground

c. Location 在視窗點選 HP5

d. Direction Vector (+z axis) 在視窗點
選 .Lower_Arm.bushing_ref的 Z-direction 

e. 與上一頁一樣修改新建立的bushing

Step 5. Create Bushings-2

e

和前一個bushing的
參考是同一個哦，
這樣才能確保兩個
的轉軸方向一樣
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To run a simulation:

a. 進行1 秒 50 步的動態模擬.

b. 將模擬結果存檔為 with_bushings.

Step 4. Run a Static Simulation

a



ADM701, Workshop 16, March 2017

Copyright©  2017 MSC Software Corporation
WS16 - 8

To review the results:

a. 開啟 Adams PostProcessor.

b. 利用 shift 鍵，將simulation裡的
with_joint 以及 with_bushing

做連選

c. 將 source 設定為 Measures

d. 在 Measure選擇 Toe_Angle

e. 按 Add Curves

Step 5. Review the Results

b

c

d
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• 存檔.

a. 利用 Export 存成 cmd檔案.

b. 關閉Adams View

Step 6. Save Your Work
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